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Welcome to MAGic 

MAGic® is a software solution ideally suited for computer users with low vision, 
or anyone who spends extended periods of time in front of a computer screen.  

MAGic lets you magnify your computer screen from 1 to 36 times its usual size. 
You can choose from a number of different adjustable views that let you see 
both a magnified and unmagnified portion of the screen at the same time.  

Speech features assist you in processing the information on your screen. 
MAGic can read text that you type or point at with the mouse. MAGic moves 
the magnified area of the screen so you always see the text being read and 
spotlights words as they are spoken.  

If you want to limit the amount of speaking performed by MAGic as you 
navigate windows and documents, use the Speech On Demand™ feature. It 
allows MAGic to only announce actions that are associated with a limited set of 
hot keys. Mouse echo is still available when using Speech On Demand.  

Mouse and cursor enhancements help you track the location of the mouse 
pointer and cursor on the screen. You can choose from a wide variety of 
enhancement styles. MAGic lets you change the color of these enhancements, 
apply transparency effects, adjust their size, and more.  

Color enhancements let you change how colors display on your screen. You 
can create rules that replace one color with another or switch two colors. You 
can also apply color tinting, make your screen black-and-white (monochrome), 
and invert the brightness and colors of your display. 

Other MAGic features track elements of your screen, such as the mouse 
pointer, dialog boxes, and so on. The Locator feature provides you with a way 
to quickly find and move to different areas of the screen. The MAGic multi-
directional panning system gives you complete control with adjustable speed, 
direction, stop and start, and screen navigation controls. 
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System Requirements 

The recommended minimum system requirements for MAGic are listed below.  

MAGic and MAGic Scripting Edition 

 64-bit Version: Windows® 7 and Windows Server® 2008 Release 2 

 32-bit Version: Windows 7 and Windows Vista® Service Pack 2 or later 

Processor speed  
Minimum 1.5 GHz processor for Windows 7 or Windows Vista  

RAM 

 Minimum 2 GB for Windows 7 (64-bit); 4 GB recommended 

 Minimum 1 GB required for Windows 7 (32-bit) or Windows Vista; 2 GB 
recommended  

Required hard disk space 
MAGic requires less than 200 MB of hard disk space for program and settings 
files. Additional space is required for the operating system, other programs, and 
the Windows swap file. For each Vocalizer Direct voice, 44 MB to 686 MB are 
required. File sizes will vary depending on the voice installed. 

Video 
DirectX 9.1 graphics device with WDDM 1.0 driver or later; DirectX 10 or later 
recommended  

Multi-monitor support  
Computer and video card that supports dual monitors; 32-bit color 
recommended; two computer monitors 

Sound  
Windows compatible sound card required for speech option. 
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Installing MAGic 

To install MAGic on your computer, do the following: 

1. Insert your program DVD. The Freedom Scientific Product Setup dialog 
box opens. 

Tip:  If your MAGic installation disk does not start automatically, click the 
Start button, select Run, and type D:\setup. If your disk drive is not 
D, substitute the correct drive letter. 

2. Press ENTER to choose the MAGic Screen Magnification button. Press 
ENTER again to choose the MAGic Setup button. 

Note: If you are installing Network MAGic, choose the MAGic Network 
Setup button instead, and then choose either the client or server 
setup. 

3. The MAGic Setup program starts. You will hear the installation speak the 
instructions as they appear on your screen. Follow these instructions to 
complete the MAGic installation. 

4. After the Setup Wizard starts, you are asked to accept the End User 
License Agreement, and then to choose between performing a typical or 
custom installation. The typical installation, which is recommended for 
most users, installs the most common program features. Use the custom 
installation if you want to specify the default location where MAGic is 
stored on your hard disk, or if you want to install client or server 
components for remote access. This type of installation is recommended 
for advanced users.  

5. When the installation is complete, choose FINISH to exit the Setup 
Wizard.  

If this is a new MAGic installation, the next step is to complete the 
activation process. Otherwise, the MAGic Startup Wizard opens. Use it to 
configure basic MAGic parameters and install basic training materials. 
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  MAGic Startup Wizard 

The MAGic Startup Wizard is a helpful tool that lets you configure specific 
MAGic parameters, such as the default magnification setting, hot key 
assignment, and startup preferences. In addition, you can install basic training 
materials. The wizard launches after you install and activate the software. You 
can always run it later from the MAGic Help menu by pressing ALT+H and 
choosing Startup Wizard. 

The Startup Settings that appear when running the wizard let you define if and 
how MAGic loads when you start Windows. The options that appear will vary 
depending on your operating system. 

Startup Settings  

The Startup Settings dialog box contains several check boxes. If you use the 
default settings, MAGic will always load and run before and after you launch 
Windows. This dialog box contains the following items:  

 Select the Start MAGic at the Log On screen check box so that MAGic 
loads and starts when the Windows log on screen appears. The check 
box is selected by default. If you have Standard user rights, you cannot 
change the value of this check box, and MAGic will ignore and not 
announce the check box.  

 If the Start MAGic after log on for all users check box is selected, 
MAGic loads and starts after you log on to Windows. It is cleared by 
default. If you have Standard user rights, you cannot change the value of 
this check box, and MAGic will ignore and not announce the check box.  

 The Start MAGic after log on for this user combo box lets an individual 
control if MAGic starts after he or she logs on to Windows. If Always is 
selected, MAGic starts every time the current user logs on. Always is the 
default setting value. If Never is selected, MAGic will not start after the 
user logs on. If Using the All Users Setting is selected, then the following 
can happen: MAGic starts after the user logs on if the Start MAGic after 
log on for all users check box is selected, or MAGic does not start if the 
same check box is cleared.  
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 Select the Run MAGic from System Tray check box to prevent the 
MAGic button from appearing in the Windows taskbar, which is located at 
the bottom of the screen, with other programs that are currently running. 
Instead, the MAGic icon appears in the Windows system tray, which is 
located in the bottom right corner of the screen, to indicate that MAGic is 
running. Finally, when this check box is selected, the MAGic icon does 
not appear in the list of active windows when you press ALT+TAB. This 
check box is cleared by default.  

 If the Minimize on Startup check box is selected, the MAGic user 
interface is minimized when MAGic starts. To open the user interface, 
choose the MAGic button in the taskbar, or press MAGic Key+U. This 
check box is cleared by default.  

Installing Vocalizer Direct Synthesizer 

Included on the program DVD is the Vocalizer Direct speech synthesizer. It 
contains a variety of voices in several languages. To install these voices, insert 
the DVD into your computer's disk drive. Then, follow the instructions to select 
which voices you want to install, and complete the installation.  

You can also sample and download Vocalizer Direct voices by visiting 
www.FreedomScientific.com, selecting the Downloads link, and then the 
Vocalizer Direct Voices link. 

Starting MAGic 

Use any of the options below to start MAGic.  

 Double-click the MAGic program icon on your Windows desktop  

 

 Press ALT+CTRL+M 

 Press WINDOWS Key+R, type "MAGic<version number>" (without the 
quotes or spaces), and press ENTER  

 Click the Start menu and choose All Programs, MAGic <version 
number>, and then MAGic.  
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Quitting MAGic  

To quit MAGic, do one of the following: 

 Press ALT+F4  

 Click the Close button  in the top right hand corner of the window.  

 Select Exit from the File menu.  

Tip:  If you want MAGic to ask you to save your settings when you quit, 
open the File menu and choose Preferences. Select the Prompt to 
Save Settings on Exit check box. 

Getting Started 

Start MAGic by pressing ALT+CTRL+M or by double-clicking the MAGic 
program icon on your Windows desktop. You can also start MAGic by opening 
the Start menu, choosing All Programs, MAGic and then selecting MAGic. 

Tip:  You can change how and when MAGic starts by opening the File 
menu and choosing Preferences. 

The first time you start MAGic after installation, your screen displays in Full 
view mode with 2x magnification. Speech is also enabled. You can change the 
magnification level, magnified view, speech, and many other options by using 
the MAGic user interface. 

User Interface Basics 

All visual, speech, and tools features are logically grouped within tabs in the 
MAGic user interface. This design makes it easy to quickly find the 
enhancements that you want to use without having to navigate down into multi-
layered settings menus. Features are laid out using split buttons where you 
click the top half to toggle the feature on or off, and click the lower half to 
display a list of standard schemes. If you want to fine-tune or create new 
schemes, you can select the Settings option in the list, which displays 
additional enhancement settings for that feature.  

If you like, you can also access other settings using the Main menu (ALT+F), 
which is located in the upper left corner of the user interface.  
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Below are the main components of the user interface.  

 

(1) Main menu button   (2) Visual tab, Speech tab, and Tools tab    
(3) Title bar   (4) Focus Indicator  (5) Minimize, Close, and Help buttons    
(6) Status bar  (7) Button/Control group, for example, Visual Enhancements 
 

Split Buttons 

Each tab contains split buttons that allow you to quickly turn on or turn off 
MAGic functionality and quickly select basic settings. This offers the 
convenience of not having to open MAGic menus to achieve the same results. 

Use the top half of the button to turn on or off specific features.  
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Use the lower half of the button to select preconfigured schemes, or select the 
Settings option to fine-tune or create a new scheme.  

 

Focus Indicator 

The Focus Indicator consists of four corner brackets that show which item in 
the user interface has focus. When you press TAB or SHIFT+TAB to move 
through the user interface, you will see the Focus Indicator move from one item 
to the next.  

 

Visual Tab and Buttons 

Below is the Visual tab. Use it to quickly control and adjust MAGic’s visual and 
magnification settings.  
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Use the items in this tab to change magnification settings. Each item is 
described below.  

Visual Tab Description 

 

Turn Visual Enhancements on or turn off. When off, all 
enhancements in the Visual tab are unavailable.  

 

Switches between the current magnification level and 
1x magnification. 

 

The current magnification level can be adjusted with 
the two Magnification Level buttons. The number in the 
box shows the current magnification level.  

 

Select your preferred view from the Magnified Views 
list. 

 

Use Mouse Enhancements to turn on or off 
enhancements and modify your mouse pointer. These 
enhancements make the mouse pointer easier to track 
and maneuver on your screen. 

 

Use Cursor Enhancements to turn on or off 
enhancements for your cursor. These enhancements 
make the cursor easier to follow when editing or writing 
text.  

 

Use Color Enhancements to turn on or off color 
enhancements. This feature allows you to replace 
colors, adjust the brightness and contrast, apply 
tinting, and invert the brightness and colors of your 
display. 
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Visual Tab Description 

 

Use Focus Enhancements to turn on or off the Focus 
Enhancements function. This function lets you define a 
rectangular border that makes it easier to identify the 
item that is currently selected on your screen. 

Speech Tab and Buttons 

Below is the Speech tab. Use it to select and adjust MAGic’s speech 
functionality.  

 

Use the items in this tab to change speech settings. Each item is described 
below.  

Speech Tab  Description 

 

Use Speech to have speech on all the time (full 
speech) or to have limited speech (Speech On 
Demand™).  

 

Move the slider left or right to adjust how fast or slow 
MAGic speaks.  

 

Use Voice Profiles to select voice settings, 
synthesizers, and languages that best fit your 
auditory preferences.  
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Speech Tab  Description 

 

Use Mouse Echo to switch the mouse echo feature 
on and off. Mouse echo enables MAGic to read text 
that you point at with the mouse.  

 

Use Typing Echo to enable or disable the typing 
echo. If typing echo is enabled, MAGic announces 
the words or characters you type 

Tools Tab and Buttons 

Below is the Tools tab. Use the Tools tab to access additional MAGic 
functionality for creating keystrokes, viewing lists of links and headings in 
documents, and more.  

 

Use the items in this tab to quickly access various MAGic links and managers. 
Each item is described below.  

Tools Tab Description 

 

Use Links to open a list of links in the current 
document. 

 

Use Headings to open a list of headings in the 
current document. 
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Tools Tab Description 

 

Use Skim Read to set preferences for browsing a 
document by the first sentence or line of a 
paragraph. You can also create rules to search for 
and read text containing specific words.  

 

Use Research It to easily search the Web for words, 
local weather forecast, news stories, sports scores, 
local businesses, and more. 

 

Use Keyboard to assign, remove, or change hot 
keys for MAGic functions. You can also create 
shortcuts to quickly launch applications, documents, 
and Web pages.  

 

Use Dictionary to change the way MAGic speaks 
words, phrases, abbreviations, or symbols.  

 

Use Script to customize MAGic for use with 
proprietary applications. This feature requires the 
MAGic Pro Scripting Edition software.  

 

The MAGic Key 

The MAGic Key is the CAPS LOCK key on your keyboard. Pressing the 
MAGic Key in combination with other keys activates a number of MAGic 
commands. If you want to assign the MAGic Key to a different key on your 
keyboard, open the Tools menu, choose Keyboard Manager, and then choose 
MAGic Key.  



 13 

Reading Text with MAGic 

MAGic can use synthesized speech to read text that appears on your screen, 
including documents, menus, dialog boxes, e-mail messages, Web pages, and 
more. Additionally, MAGic can spotlight the text as it is spoken. To customize 
MAGic’s speech, use the commands available on the Speech menu. 

Tip:  You can silence MAGic’s speech at any time by pressing CTRL. To 
toggle speech on or off, press MAGic Key+F3. 

Using the Mouse to Read Text 

Mouse echo is a feature that allows you to read text with your mouse. To use 
mouse echo, just move your mouse pointer to some text on your screen and 
then stop. After a short delay, MAGic will speak the word you pointed to. You 
can use the Mouse Echo button to enable or disable this feature.  

In addition, you can hold down the MAGic Key and press the left mouse button 
to start reading from the current location of the mouse pointer. You do not need 
to hold down the MAGic Key while MAGic reads. MAGic stops reading when 
you move the mouse or press a key. 

Using the Keyboard to Read Text 

MAGic has a number of different keystrokes that let you use the keyboard to 
read text. To use these keystrokes, move the insertion point or mouse pointer 
to any location within the document. Then press one of the following key 
combinations to read from that location: 

 To begin reading from your current location, press INSERT+DOWN 
ARROW.  

 To read the current character, press NUM PAD 5. 

 To read the current word, press MAGic Key+ALT or INSERT+NUM PAD 
5. To spell the current word, press the keystroke twice quickly. 

 To read the next word, press INSERT+RIGHT ARROW. To read the 
previous word, press INSERT+LEFT ARROW. 

 To read the current line, press MAGic Key+L or INSERT+UP ARROW. 
To read the next line, press DOWN ARROW. To read the previous line, 
press UP ARROW. 
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 To read from the beginning of the line to the current position of the cursor, 
press INSERT+HOME. To read from the current position of the cursor to 
the end of the line, press INSERT+PAGE UP. 

 To read the current sentence, press MAGic Key+S. To read the next 
sentence, press CTRL+MAGic Key+S. 

 To read the current paragraph, press MAGic Key+P. To read the next 
paragraph, press MAGic Key+ CTRL+P or CTRL+DOWN ARROW. To 
read the previous paragraph, press MAGic Key+ ALT+P or CTRL+UP 
ARROW. 

 To read text that you have selected, press INSERT+SHIFT+DOWN 
ARROW.  

 To hear the contents of the Clipboard, press MAGic Key+X. 

 To read the contents of the Clipboard using the Clipboard Text Viewer, 
press MAGic Key+SPACEBAR, followed by C or INSERT+SPACEBAR, 
followed by C.  

Note:  By default, the MAGic Key is assigned to the CAPS LOCK key. To 
change this, open the Tools menu, choose Keyboard Manager, 
and then choose the MAGic Key button.  

When you read text with these keystrokes, MAGic spotlights the word it is 
currently speaking. To change the color or style of this spotlighting, open the 
Speech menu and choose Spotlight Options.  

Reading Text in Dialog Boxes 

In addition to the reading commands listed previously, you can use the 
following keystrokes to hear information in Windows dialog boxes: 

 To read the title bar of the active window or dialog box, press MAGic 
Key+T or INSERT+T. 

 To read the bottom of the active window (which usually contains the 
status bar), press INSERT+PAGE DOWN. To read the top line of the 
active window (which usually contains the title bar), press INSERT+END. 

 To hear the name of the default button that will be activated when you 
press ENTER, press INSERT+E. 
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 To read the currently selected dialog box option (such as an edit box or 
check box), press MAGic Key+TAB or INSERT+TAB.  

 To hear the access key for the currently selected dialog box option, press 
SHIFT+NUM PAD 5. 

Getting Help  

Online Help System 

You can press F1 or use the  button to open the MAGic help file. You can 
also open the file by choosing the Main menu button, the Help submenu, and 
then Help Topics. The help file provides a full-text search, index, and table of 
contents to help you find the information you need.  

If you want MAGic to read the help topics to you, position the mouse pointer 
toward the beginning of the help page, and press MAGic Key+SPACEBAR. 
You can move to the next topic by clicking the "Next" link at the bottom of the 
page. To return to the previous topic, click the "Back" link.   

What’s This? Help 

MAGic’s What’s This? help is context-sensitive help that you can use as a 
reference when working with MAGic’s user interface or dialog boxes. Press 
SHIFT+F1 on any button on the user interface, or control in a dialog box to see 
a brief description of the purpose of the control and how to use it.  

For mouse users, most dialog boxes contain a  button in the top, right corner. 

Click the  button to change your mouse pointer into the What's This? Help 
pointer (see below). Move your pointer to the control you need more 
information about, and click the mouse on the control to see the What’s This? 
help. If you do not find enough information in the What’s This? help, try 
referring to the full help system. 

 

What’s This? Help button 

 

What’s This? Help pointer 

MAGic User’s Guide 

The user’s guide contains content available in the MAGic online help system 
and is printed in large text for easier reading. It contains detailed descriptions of 
MAGic’s features, and also pull-out reference cards. 
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MAGic Basic Training 

Listen to the MAGic Basic Training to learn the fundamentals of using MAGic 
Screen Magnification. For more information, see FSReader and Training 
Materials below. 

Technical Support 

If you do not find the answers to questions or problems that you have, contact 
Freedom Scientific Technical Support, (727) 803-8600. 

About MAGic  

Select About MAGic from the Help menu on the MAGic user interface to view 
the version number of MAGic you are currently running. 

FSReader and Training Materials 

The MAGic program disk includes basic training materials in a digital document 
format known as DAISY (Digital Accessible Information System). You can listen 
to and read the training modules by using the FSReader (a demonstration 
version of Freedom Scientific’s DAISY reader), which is automatically installed 
with MAGic. By default, at least one DAISY book (FSGettingStarted) is also 
installed. 

Installing Training Materials When Installing MAGic 

After initially installing MAGic from the MAGic product disk, the MAGic Startup 
Wizard launches and prompts you to install training materials, which consists of 
two DAISY books (MAGic Basic Training and What’s New). To install these 
books, select the Install Training Materials check box, choose NEXT, and follow 
the remaining on-screen directions.  

Note:  There is an entire series of training and tutorial DAISY books 
available for Web download from Freedom Scientific. Use the Check 
for Updates function, as described in the following section, to select 
and download additional DAISY books, or visit the Training Web 
page on the Freedom Scientific Web site. 
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Installing Training Materials Later  

If you decide not to install training materials during the initial product 
installation, you can always use Check for Updates to select, download, and 
install training files later. To install training materials, do the following: 

1. Press ALT+CTRL+M to open the MAGic application window.  

2. Press ALT+H to choose the Help menu, and the press P to choose 
Check for Updates.  

3. MAGic searches for and then displays a list of DAISY books available to 
download. Use the arrow keys to move through the list, and press the 
SPACEBAR to select the check box next to each book that you want to 
download and install. You can choose the Details button to view more 
information about the currently selected book. 

4. Choose the Install button to receive the selected books. 

5. When complete, a dialog box opens announcing that files were 
successfully installed. It also states which files were installed. Press 
ENTER to close the dialog box. Open FSReader to read these books. 

Starting and Using FSReader  

Do the following to start FSReader from the MAGic dialog: 

1. Select a DAISY book from the Open dialog, and choose the Open button. 
The selected book appears in FSReader.  

2. Press ALT+H, T. The Open dialog appears.  

3. Select a DAISY book from the Open dialog, and choose the Open button. 
The selected book appears in FSReader.  

4. Press CTRL+P to begin reading the book. Press CTRL+P again to pause 
reading the book. To fast forward five seconds, press CTRL+PERIOD. To 
rewind the book five seconds, press CTRL+COMMA.  

Note:  As long as FSReader is running, CTRL+P will toggle between play 
and pause. If you want to print while FSReader is active, you must 
use an application’s Print command. 

5. When you are finished reading the book, press ALT+F, O to open 
another DAISY book, or press ALT+F, X to close and exit FSReader 
Demo. 
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Updating MAGic 

Freedom Scientific is continually seeking to improve and expand MAGic for 
Windows. Periodically, updates to MAGic will be released. It is recommended 
that you keep your software up-to-date so that you experience the greatest 
possible performance. In addition, Freedom Scientific will also provide new and 
updated DAISY training materials for you to download.  

Updating your software is quick and easy. To search for updates to MAGic or 
new training materials, do the following: 

1. Press ALT+CTRL+M to open the MAGic application window. 

2. Press ALT+H to open the Help menu. 

3. Press P to select Check for Updates. The update feature determines if 
you have the most current release. If you do not, select one or more 
items from the list and then select INSTALL to begin the update. All 
enhancements since the initial public beta release are included in the 
update. If the updates are not installed successfully, repair your 
installation of MAGic (refer to the online help for more information) and 
then try the procedure again. 

Note:  If your computer has active firewall software (such as Windows 
Firewall), you may receive a warning indicating that either the 
FSAutoUpdate Application or FSAutoUpdate.exe is attempting to 
access the Internet. You must allow this process to access the 
Internet through the firewall in order to retrieve updates. 
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MAGic Hot Keys 

Note: By default, the MAGic Key is the CAPS LOCK key on your 
keyboard. Some actions in MAGic do not have hot keys assigned. 
You can define hot keys for these features using the Keyboard 
Manager. 

General 
Description General Keystrokes 

Start MAGic 

CTRL+ALT+M (default 
keystroke – can be changed 
using the Startup Wizard) 

Run Script Manager  
(MAGic Pro Scripting Edition 
only) INSERT+0 

Minimize/Restore the MAGic 
User Interface MAGic Key+U 

Pass Through Key MAGic Key+3 

Refresh Screen MAGic Key+ESC 

Open MAGic Context Menu 

MAGic Key+APPLICATION 
Key or  
MAGic Key+RIGHT MOUSE 
BUTTON CLICK 

Quick Settings MAGic Key+O 

Toggle Navigation Quick Keys 
On/Off MAGic Key+Z 

Append Text to Current 
Contents of Clipboard MAGic Key+WINDOWS Key+C 
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General Layer  

Press and release INSERT+SPACEBAR, followed by a keystroke listed below 
to perform the action. (To exit Layer Keystroke mode, press ESC, SPACEBAR, 
TAB, or ENTER.) 

Description General Keystrokes 

Mute Speech S 

Launch Research It R 

Screen Capture of Entire 
Screen CTRL+C, S 

Screen Capture of Active 
Window CTRL+C, W 

Open Clipboard Text Viewer C 

Magnification, Views, and Enhancements 

Description 
Magnification, Views, and 
Enhancements Keystrokes 

Increase Magnification  

MAGic Key+NUM PAD PLUS 
or  
CTRL+EQUAL or  
MOUSE WHEEL UP (scroll 
wheel up or away from you) 

Decrease Magnification 

MAGic Key+NUM PAD MINUS 
or  
CTRL+DASH or  
MOUSE WHEEL DOWN (scroll 
wheel down or towards you) 

Magnification Toggle On/Off MAGic Key+DELETE 
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Description 
Magnification, Views, and 
Enhancements Keystrokes 

Toggle between 1x 
Magnification and Current 
Magnification 

MAGic Key+SHIFT+DELETE or 
MAGic Key+MOUSE MIDDLE 
CLICK (press down on scroll 
wheel) 

Switch to Next Magnified View MAGic Key+NUM PAD SLASH 

Switch to Previous Magnified 
View 

MAGic Key+SHIFT+ 
NUM PAD SLASH 

Change Text Smoothing View 
(HD Text, Classic, and None) MAGic Key+CTRL+F 

Toggle Color Enhancements 
On/Off MAGic Key+F12 

Toggle Cursor Enhancements 
On/Off MAGic Key+F8 

Toggle Mouse Enhancements 
On/Off MAGic Key+F4 

Toggle Focus Enhancements 
On/Off MAGic Key+F 

Panning and Screen Movement 

Description 
Panning and Screen 
Movement Keystrokes 

Pan Right MAGic Key+RIGHT ARROW 

Pan Left MAGic Key+LEFT ARROW 

Pan Down MAGic Key+DOWN ARROW 

Pan Up MAGic Key+UP ARROW 

Increase Speed during Panning NUM PAD PLUS  
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Description 
Panning and Screen 
Movement Keystrokes 

Decrease Speed during 
Panning NUM PAD MINUS 

Move to Left Edge of Screen  MAGic Key+HOME 

Move to Right Edge of Screen MAGic Key+END 

Move to top of Screen MAGic Key+PAGE UP 

Move to Bottom of Screen MAGic Key+PAGE DOWN 

Move to Beginning of Next Line MAGic Key+ENTER 

Tracking 

Description Tracking Keystrokes 

Tracking Toggle On/Off  MAGic Key+R 

Move View to Mouse Pointer MAGic Key+NUM PAD 5 

Move View to Cursor 
SHIFT+MAGic Key+ 
NUM PAD 5 

Tether Mouse to Display 
CTRL+INSERT+ 
NUM PAD MINUS 

Cursor Movement 

Description Cursor Movement Keystrokes 

Route Cursor to Mouse INSERT+NUM PAD PLUS 

Route Mouse to Cursor INSERT+NUM PAD MINUS 
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Locator Mode 

Description Locator Mode Keystrokes 

Start Locator MAGic Key+F10 

Stop Locator and Move to 
Selected Area ENTER 

Stop Locator without Moving the 
Magnified Area ESC 

Move Left LEFT ARROW 

Move Right RIGHT ARROW 

Move Up UP ARROW 

Move Down DOWN ARROW 

Move to Far Left Side of Screen HOME 

Move to Far Right Side of 
Screen END 

Move to Top of Screen PAGE UP 

Move to Bottom of Screen PAGE DOWN 

Quick View Frame 

Description Quick View Frame Keystrokes 

Toggle Quick View Frame 
On/Off MAGic Key+Q 

Set upper left corner of frame MAGic Key+LEFT BRACKET 

Set lower right corner of frame MAGic Key+RIGHT BRACKET 
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Description Quick View Frame Keystrokes 

Create frame around current 
dialog box option 

MAGic Key+LEFT BRACKET 
twice quickly 

Open Quick View Manager MAGic Key+9 

Speech 

Description Speech Keystrokes 

Silence Current Speech CTRL 

Enable/Disable Speech MAGic Key+F3 

Increase Speech Rate and Save 
New Rate 

WINDOWS Key+ALT+ 
CTRL+PAGE UP 

Increase Speech Rate - 
Temporary ALT+CTRL+PAGE UP 

Decrease Speech Rate and 
Save New Rate 

WINDOWS Key+ALT+ 
CTRL+PAGE DOWN 

Decrease Speech Rate - 
Temporary ALT+CTRL+PAGE DOWN 

Voice Profiles MAGic Key+F11 

Set Screen Echo INSERT+S 

Select Verbosity Scheme INSERT+ALT+S 
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Document and Text Reading 

Note: When using the document and text reading commands, if you move 
the mouse MAGic reads from the current location of the mouse 
pointer. If you move the insertion point, MAGic reads from the 
location of the insertion point. 

 

Description 
Document and Text Reading 
Keystrokes 

Read All from Location (Say All) 

INSERT+DOWN ARROW or 
MAGic Key+A or  
MAGic Key+LEFT MOUSE 
BUTTON CLICK  

Alternate Say All 

INSERT+ALT+DOWN ARROW 
or  
MAGic Key+ALT+LEFT 
MOUSE BUTTON CLICK  

Read Active Window (reads 
from the beginning of document 
window) 

INSERT+DOWN ARROW 
(twice) 

Say Currently Selected Text 
INSERT+SHIFT+DOWN 
ARROW 

Say Current Character NUM PAD 5 

Say Current Word 
MAGic Key+ALT or 
INSERT+NUM PAD 5 

Spell Current Word 
MAGic Key+ALT (twice) or 
INSERT+NUM PAD 5 (twice) 

Next Word INSERT+RIGHT ARROW 

Prior Word INSERT+LEFT ARROW 

Select Next Word 
INSERT+SHIFT+RIGHT 
ARROW 
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Description 
Document and Text Reading 
Keystrokes 

Select Prior Word INSERT+SHIFT+LEFT ARROW 

Say Current Line 
MAGic Key+L or  
INSERT+UP ARROW 

Next Line DOWN ARROW 

Prior Line UP ARROW 

Read to Cursor INSERT+HOME 

Read from Cursor INSERT+PAGE UP 

Say Current Sentence MAGic Key+S 

Next Sentence MAGic Key+CTRL+S 

Say Current Paragraph MAGic Key+P 

Say Next Paragraph 
MAGic Key+CTRL+P or  
CTRL+DOWN ARROW 

Say Prior Paragraph 
MAGic Key+ALT+P or  
CTRL+UP ARROW 

Say Contents of Clipboard MAGic Key+X 

Skim Read 
INSERT+CTRL+DOWN 
ARROW 

Skim Reading Preferences 
INSERT+CTRL+SHIFT+DOWN 
ARROW 

Dialog Box Reading 

Description 
Dialog Box Reading 
Keystrokes 

Say Title Bar 
MAGic Key+T or  
INSERT+T 
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Description 
Dialog Box Reading 
Keystrokes 

Read Bottom of Window INSERT+PAGE DOWN 

Say Top Line of Window INSERT+END 

Say Default Button in Dialog 
Box INSERT+E 

Say Window Prompt and Text 
MAGic Key+TAB or  
INSERT+TAB 

Say Current Access Key SHIFT+NUM PAD 5 

Table Reading 

Description Table Reading Keystrokes 

Say Current Cell ALT+CTRL+NUM PAD 5 

Cell to Right ALT+CTRL+RIGHT ARROW 

Cell to Left ALT+CTRL+LEFT ARROW 

Cell Below ALT+CTRL+DOWN ARROW 

Cell Above ALT+CTRL+UP ARROW 

First Cell ALT+CTRL+HOME 

Last Cell ALT+CTRL+END 

First Cell in Column 
ALT+CTRL+SHIFT+UP 
ARROW 

Last Cell in Column 
ALT+CTRL+SHIFT+DOWN 
ARROW 

First Cell in Row 
ALT+CTRL+SHIFT+LEFT 
ARROW 
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Description Table Reading Keystrokes 

Last Cell in Row 
ALT+CTRL+SHIFT+RIGHT 
ARROW 

Table Layer Keystrokes 
Press and release INSERT+SPACEBAR, followed by the keystrokes below to 
navigate and read tables. (To exit Table Layer Keystroke mode, press ESC, 
SPACEBAR, TAB, or ENTER.) 
 

Description Table Reading Keystrokes 

List Keystrokes Available in this 
Layer T, SHIFT+SLASH 

Move to Cell Above 
T, UP ARROW or  
T, ALT+CTRL+UP ARROW 

Move to Cell Below 

T, DOWN ARROW or  
T, ALT+CTRL+SHIFT+RIGHT 
ARROW 

Move to Cell to Left 
T, LEFT ARROW or  
T, ALT+CTRL+LEFT ARROW  

Move to Cell to Right T, RIGHT ARROW 

Say Current Cell 

T, NUM PAD 5 or  
T, ALT+CTRL+NUM PAD 5 or  
T, ALT+COMMA 

Move to Beginning of Current 
Row 

T, HOME or  
T, ALT+CTRL+SHIFT+LEFT 
ARROW 

Move to End of Current Row 

T, END or  
T, ALT+CTRL+SHIFT+RIGHT 
ARROW 

Jump to First Cell in Table 
T, CTRL+HOME or  
T, ALT+CTRL+HOME 
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Description Table Reading Keystrokes 

Jump to Last Cell in Table 
T, CTRL+END or  
T, ALT+CTRL+END 

Move to Beginning of Current 
Column 

T, CTRL+UP ARROW or  
T, ALT+CTRL+SHIFT+UP 
ARROW 

Move to Bottom of Current 
Column 

T, CTRL+DOWN ARROW or  
T, ALT+CTRL+SHIFT+DOWN 
ARROW 

Move to Beginning of Current 
Row T, CTRL+LEFT ARROW 

Move to End of Current Row T, CTRL+RIGHT ARROW 

Jump to Next Table 
T, CTRL+ENTER or  
T, ALT+CTRL+ENTER 

Jump to Prior Table 
T, CTRL+SHIFT+ENTER or  
T, ALT+CTRL+SHIFT+ENTER 

Read the Current Row 
T, SHIFT+UP ARROW or  
T, WINDOWS Key+COMMA 

Read from Current Cell T, SHIFT+PAGE UP 

Read to Current Cell T, SHIFT+HOME 

Read Current Column 
T, SHIFT+NUM PAD 5 or  
T, WINDOWS Key+PERIOD 

Read to Bottom of Column T, SHIFT+PAGE DOWN 

Read from Top of Column T, SHIFT+END  

Jump to Previous Cell  

T, WINDOWS Key+J or  
T, CTRL+SHIFT+WINDOWS 
Key+J 
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Typing Echo 

Description Typing Echo Keystrokes 

Cycle through Indicate 
Capitalization options MAGic Key+F2 

Cycle through Typing Echo Unit 
options INSERT+2 

Mouse Echo 

Description Mouse Echo Keystrokes 

Mouse Echo Toggle MAGic Key+M 

Note: Toggling the mouse echo rotates between speak lines, speak words, 
and mouse echo off. 

Multi-Monitor 

Description Multi-Monitor Keystrokes 

Switch focus between monitors MAGic Key+SHIFT+D 

Restrict the mouse pointer to 
the active monitor MAGic Key+SHIFT+R 

Move the current application or 
window in focus to the monitor 
on the right or the left  

WINDOWS Key+SHIFT+RIGHT 
ARROW or  
WINDOWS Key+SHIFT+LEFT 
ARROW 

View Lock. Press and hold and 
drag mouse to move the mouse 
pointer between screens without 
scrolling any screen content. MAGic Key+SHIFT 
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Description Multi-Monitor Keystrokes 

In Overview mode, toggles 
mouse, cursor, color, and focus 
enhancements on and off on the 
unmagnified monitor. 

Press and hold MAGic 
Key+SPACEBAR, and then 
press D followed by E. 
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Windows Shortcut Keys 

General 

Description General Shortcut Keys 

Get Help F1 

Open the Start menu 
WINDOWS Key or  
CTRL+ESC 

Open Windows Explorer WINDOWS Key+E 

Open the Run dialog box WINDOWS Key+R 

Find file or folder from Desktop F3 

Minimize all windows WINDOWS Key+M 

Switch between programs ALT+TAB 

Quit the active program ALT+F4 

For Windows and Menus 

Description 
Windows and Menus Shortcut 
Keys 

Open the application control 
menu ALT+SPACEBAR 

Move to the menu bar ALT 

Choose a menu command ENTER 

Move between menus ALT, arrow keys 

Close a menu ESC 

Close a cascading menu ALT 
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Description 
Windows and Menus Shortcut 
Keys 

Open a child window control 
menu ALT+HYPHEN 

Close a child window CTRL+F4 

Open the context menu 
APPLICATION Key or  
SHIFT+F10 

For Dialog Boxes 

Description Dialog Boxes Shortcut Keys 

Move through dialog box 
options TAB 

Move backward through dialog 
box options SHIFT+TAB 

Move to another tab CTRL+TAB 

Reverse direction through tabs CTRL+SHIFT+TAB 

Move to first option HOME 

Move to last option END 

Select or clear an item in a list 
SPACEBAR or  
CTRL+SPACEBAR 

Select or clear a check box SPACEBAR 
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For Reading Text 

Description Reading Text Shortcut Keys 

Move left one character LEFT ARROW 

Move right one character RIGHT ARROW 

Move left one word  CTRL+LEFT ARROW 

Move right one word  CTRL+RIGHT ARROW 

Move to beginning of line HOME 

Move to end of line END 

Move up one paragraph CTRL+UP ARROW 

Move down one paragraph CTRL+DOWN ARROW 

Scroll up one screen PAGE UP 

Scroll down one screen PAGE DOWN 

Move to beginning of document CTRL+HOME 

Move to end of document CTRL+END 

For Editing Text 

Description Editing Text Shortcut Keys 

Copy CTRL+C 

Cut CTRL+X 

Paste CTRL+V 

Undo CTRL+Z 

Delete character to the left BACKSPACE 

Delete character to the right DELETE 
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Description Editing Text Shortcut Keys 

Select one character left SHIFT+LEFT ARROW 

Select one character right SHIFT+RIGHT ARROW 

Select one word left CTRL+SHIFT+LEFT ARROW 

Select one word right CTRL+SHIFT+RIGHT ARROW 

Select to beginning of line SHIFT+HOME 

Select to end of line SHIFT+END 

Select to beginning of document CTRL+SHIFT+HOME 

Select to end of document CTRL+SHIFT+END 

Select all CTRL+A 

For Windows Explorer 

Description 
Windows Explorer Shortcut 
Keys 

Rename selected file or folder F2 

Open properties ALT+ENTER 

Refresh a window F5 

Switch between panes 
F6 or  
TAB 

Go up a level BACKSPACE 

 

 


